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ASSTIGNMENT

ally call the CPU the "brain" of the
this is where programs are executed. A

accomplish a specific task, such as sending a file to the printer,
opening a browser window, or playing music or video.




The CPU is further broken up into three smaller components: the
arithmetic unit handles all the simple mathematical computations; the
control units interpret the instructions in a computer program; and the
instruction decoding unit converts computer programming
instructions into machine code. Machine cocﬁthe basic language
understood by all the components in a computer.

Memory

Once the CPU converts a speci
into machine code, it stores that

controller nects to the CPU and primary memory, and it has a set
of instructions that tells the CPU how to use it.




QOutput Units

Output units are the devices your computer uses to relay information to
the user, such as a printer, monitors and speakers. For example,
everything you see on your computer monitor starg§yas machine code in
memory. The CPU takes that machine code and c it into a format
required by your monitor's hardware. Your

converts that information into different

words or pictures

COMPUTER BLO




Q2: discuss about the classification of computer based on
size and capacity?

Ans. Based on size and capability, computers are broadly classified into

64 bit processor with speed of
Examples: - IBM PCs, APPL

Microcomputer can be classified
Desktops
Portables
avelling whereas

ilar to a desktop computers but the size is
e than desktop. The weight of laptop is

computers are as powerful as desktop but size of
these computers are comparatively smaller than laptop and desktop.
They weigh 2 to 3 kg. They are more costly than laptop.




Palmtop (Hand held): - They are also called as personal Digital
Assistant (PDA). These computers are small in size. They can be held in
hands. It is capable of doing word processing, spreadsheets and hand
writing recognition, game playing, faxing and paging. These computers
are not as powerful as desktop computers. Ex: - 3cim palmV.

small so that it
can be worn on the body. It has smaller processing power. It is used in

Wearable computer: - The size of this computer

the field of medicine. For example pace maker to correct the heart beats.

Insulin meter to find the levels of insulin in the blood.

) Mainframe comput

capacities and very high spee

microcomputers) are known a : support a
large number of terminals for simult er of users
like ATM transactions. They are also us

distributed data pg@eessing system.

d)
storage ] igispeeds which are many times faster than
is measured in terms of tens of
an operation is made up of

cather ana :
Examples: - IBM Deep Blue

a4




Q3: what 1s the meaning of computer generation? How many
computer generations are defined? What tec
used?

First Generation
In the late 1940s and early 195

used vacuum tubes for their dig
for storage.

Second Generation

In the late 1950s, t

memorie
was si i

rames and minicomputers, essentially large
s and small departmental computers. See

Fourth Generation

The mid to late-1970s spawned the microprocessor and personal
computer, introducing distributed processing and office automation.




Word processing, query languages, report writers and spreadsheets put
large numbers of people in touch with the computer for the firsttime.

Fifth Generation - The Future
The 21st century ushered in the fifth generation, which increasingly

delivers various forms of artificial intelligence (A ore sophisticated
search and natural language recognition are featur

recognize, but software that improves its function arning onits
own will change just about everything in h world in

TECHNOLOGIES WERE/A}

Communications te
Office productivity. ...




Q4: Differentiate between volatile & non-
volatile memories.

What is Volatile Memory?

Volatile Memory is the kind of computer
temporarily. It is also referred as tempora
memory is stored only until the power is s

automatically. RAM and cache o

example of the volatile memory.

its stores only the frequently used

the processor is stored in volatile memory.
nature and can be accessed rapidly. Volatile
performance of th

the more effective

memory that stores the data
The data stored ¥mthe non-volatile memory remains there even
is turned off. of the computer is the non-volatile
t and fast in nature as compare to volatile
onger period. Non-volatile memory possesses

starting up information and BIOS. Non-volatile memory is slow
i 1l such data that needs to be stored permanently or for
ed in non-volatile memory. Non-volatile memory has a
system’s storage capability. The more non-volatile
memory, the more permanent storage space will be there. Common examples
of non-volatile memory include a hard drive, optical discs, flash memory,etc.




Volatile Memory vs. Non-Volatile Memory

Volatile Memory is the temporary memory of the computer
system.

Non-volatile Memory is the permanent memory of thecomputer
system.

Data of programs in the process and freque

in volatile memory.

System’s information, BIOS and

in non-volatile memory.

Volatile memory is fast and efficie

Non-volatile memory is slew and pe

QS5: Distinguish among system softwar
source software on the basis of their featu

Ans. Differen
softwar urce

Sr. Key System Software. Application Software.

No
.
Defin Ne is the type of On other hand Application
ich'is the interface Software is the type of software
1 icati which runs as per user request. |
runs on the platform which is
provide by system software.
A )

In general System software are While in case of Application
Lan developed in low level language software high level language is
2 which is more compatible with the used for their development as th
system hardware in order to interact are developed as some specific
with. purpose software.




System Software. Application Software.

System software is used for On other hand Application
operating computer hardware. software is used by user to
perform specific task.

| N

Installation System software are installed on ' r hand Application

the computer when operati
system is installed. A

User As mentioned in above p
interaction re speci
less or

ot
Dependency System software can run On other hand in application
ependently. It provides plat ’tware can’t run independently.

ning application software. ey can’t run without the

resence of system software..

On other hand some examples of

sembler, application software’s are word
processor, web browser, media
player, etc.

Open Sources

rce software?

ware is software with source code that anyone
can inspect, modify, and enhance.




"Source code" is the part of software that most computer users
don't ever see; it's the code computer programmers can
manipulate to change how a piece of software—a "program" or
"application"—works. Programmers who have access to a
computer program's source code can improve_that program by
adding features to it or fixing parts that don'

correctly.

What's the difference between op
other types of software?

Some software has source ¢
organization that created it

order to use
ers must agree (usually by
yne they run this software)
g with the software that the
pressly permitted. Microsoft

nd save it with file name “yourself”.
ps involved in it.

Ans. we have some steps of ms word.




Firstly we go to the Ms Word.
Then we type our text in Ms Word.

After type the text we go to the offi

Then click on save option.

After that we give file nam«
e Then we select save

e Then click on ok.

“ Firstly we select the given text.

“ Then we go to the home tab.




% After that we go to the font group.

“ Then we go to the font style and we will saw different
type of font style.

% After that we click on any one font st

To change the font size.

“+To highlight (in vellow) the line that reads “need to
get IMS’s address”




firstly we select the given text ““ need to get IMS’s
address”

then click on home tab

Then we click on text highlight col font group.

After that we choose yellow,

. Create a file in Ms-Word for
and save it with file nam
involved 1n it.

Ms-Word is widely used commercial word processor
Ms-Word is applicatio are which is capable of

Creating

2. Type “Ms-word is application software which is capable of” then press enter
key

3. After that select “bullet” from “bulleted list” from “home tab”.




4. Then type “creating” and press “enter key”. Then type
“Editing” and press “enter key”. After that type “saving and
press enter key”. Then we type “printing any type of
document” and press “enter key”.

5.2

6. Then we select word processor then we
we go to font group and we click g

7. After that we select the creating texta
on font color and select s

8. Then we select saving tex
color and select red color.




Ans: we have some steps which we follow.

e Firstly we open the Ms-Word and write the
equations.

Next we type X then we go to fi
click on subscript then prg

+ button from keyboard.

we do subscript and pres

oard. Then we type B and do
from font group. Then we type 8.
¢ press = button. Then we type X
and again we do subscript. And press 2. Then we
press on + button. After that we type Y. then we
do superscript. And type 8.




o After that we go to the office button. And click
on save. After that we have give the file name
‘equations’ then click on save option.

Q9. Create a file in Ms-word that ¢
highlight text to table as shown belo
file name ‘text to table’ descsi

it.

Select the insert tab.

Select the u want to convert. Select the insert tab.

Click on table command. A dialog box Click on convert text to table, a new dialog box
appears. appears.

Here set number of columns. Click on ok finally selected text convert in atable.




Ans. We have followed some steps.
e Firstly we select the text.
e Then go to insert tab.

e Then we go to the table option.

e Then we select on se
paragraph.

o After that wic

go to the Ms-word.

e Then we go to the insert tab.




e After that we click on table.

e And go to insert table option.

e Then we select the rows numbergccording you
wants. And then you select colu
And click on ok.

e After that you will saw a

Q11. Create a followin ksh
save 1t with name ‘book®1’

e |

QORYaUhUNE

P




Ans: we have followed some steps.
e Firstly we go to Ms-excel. And open a sheet
e Then we type Roll no on a colu

e After that we type Roll no I3
downwards.

e Thenwe gotobc
After that we type
downward.

eet created i question no 10.

f the marks using Auto sum in a
range of cells (c2:cll)

e Average of the marks in a range of cells (c2:c11)




e Highest marks in a range of cells (c2:c11)

e Minimum marks in a range of cells (c2:cl1)

Ans: we have followed some steps

Then we type =SUM (c2
enter.

e For average firstly
Then we type =AV

y column width of a worksheet.

e To modify the row height of a worksheet.




e To delete rows and columns of a worksheet.

Q13. (b) Describe following terms in the worksheet.

e Absolute reference and relative reference in
formula

e Cell address

4. In the Colum
5. Click O

casing the column width.
ialog box appears. Enter a specific

5. Click OK.




3. if you don't need any of the existing cells, rows or columns,
here's how to delete them:

1. Select the cells, rows, or columns that you want to delete.

2. On the Home tab, click the arrow under Delete, and then click
the appropriate delete option.

Ans.13 (b) Absolute reference and
formula

Relative references

By default, all cell references are relative references. When
copied across multiple cells, they change based on the relative
position of rows and columns. For example, if you copy the
formula =A1+B1 from row 1 to row 2, the formula will
become =A2+B2. Relative references are especially convenient
whenever you need to repeat the same calculation across
multiple rows or columns.

To create and copy a formula using relative references:

In the following example, we want to create a formula that will
multiply each item's price by the quantity. Rather than create a
new formula for each row, we can create a single formula in
cel and them¢opy it to the other rows. We'll use relative
refere ormula correctly calculates the total for each

1tem.




e (Cell address

The cell ADDRESS function is categorized under Excel Lookup
and Reference functions. It will provide a cell reference (its
“address”) by taking the row number and column letter. The cell
reference will be provided as a string of text. function can
return an address in a relative or absolute fo can be used
to construct a cell reference inside a

1. Row_num (required argument) — This is a numeric value
specifying the row number to be used in the cell reference.

2. Column_num (required argument) — A numeric value
specifying the column number to be used in the cell
reference.

3. Abs_num (optional argument) — This is a numeric value
specifying the type of reference to return:




Q14. (a) What tools are available to customize our
PowerPoint presentation?

Ans (a) 1. Visme

Visme is a cloud-based presentation tool thaMs you to
create highly visual presentations to engage viewers and
communicate your ideas. It features an intuitive, drag-and-drop
design method for creating presentations. The business version
also prioritizes brand consistency and company-wide image
storage. When you or your employees create a presentation, it
will feature colors, logos and images that are on brand for your
organization. This promotes consistency across presentations
among your employees. Visme also offers a built-in analytics
system, so you can see who has viewed your presentation and
who finished it.

Visme offers multiple plans ranging from $20 per user per
month to $60 per three users per month. It's also possible to get
a free live demo to see how the technology works before you try
it out.

2. Haiku Deck

Haiku Deck is a platform that prioritizes simplicity. Business
elegant, basic presentations with high-quality
' an approach allows for connecting with
audiences 1nstead of losing them in information overload due to
text-heavy slides. What separates Haiku Deck from traditional
presentation tools is its library of images and array of fonts. It




makes it easy to craft simple, powerful presentations that are
accessible on any device.

Haiku Deck offers three plans, ranging from $7.99 to $29.99 per
month.
A

3. Pitcherific

Pitcherific is not only a presentation solution, but also a platform
for building and practicing your presentation. It's a template-
based program that guides you through the presentation creation
process. Instead of drafting a few slides, Pitcherific prompts you
to write out the areas of each part of your speech. The outline for
an elevator pitch, for example, includes a hook, problem,
solution and closing. There are various templates for different
kinds of pitches and presentations, so you'll have guidance on
many kinds of speeches and presentations. Pitcherific also
recommends a character count for each section and a timeclock,
allowing you to track how long your speech or presentation is
and stay within a desired range.

Pitcherific's pricing depends largely on your business and its
needs, so you'll have to reach out to its sales team to get a direct
quote. Pitcherific does offer a free trial in case you're curious to
see how the platform works.

4.

Canva is an online platform that provides templates for a wide
range of business-related publications, like resumes, newsletters,
business cards, media kits, brochures and info graphics. You can
also use it to construct presentations. There are hundreds of




design layouts and templates to start with, and you can upload
your own images or choose from more than 1 million of
Canvas’s stock images. As you build your presentation, you can
adjust text and fonts, add filters to images, and drag and drop
different elements for design. You can also upload and save
your company logo. k

Canva offers a free version equipped with all its features. If
you're a startup or very small business owner, this is a good
option. For larger businesses, Canva for Work offers team
management features for $12.95 per month (or $9.95 per month
when you pay annually). You can try this version free for 30
days.

5. Slide Camp

Slide Camp provides slide templates for creating company
presentations. You can adjust color schemes, add company
logos, import charts and data, build info graphics, and organize
presentations into sections with Slide Camp. This is a great
solution for maintaining presentation consistency across
multiple presentations from your organization. After you set up
branding details, employees will be able to work with
predesigned slides to easily craft professional presentations. It's
geared for larger businesses, so if you're a startup or one-person
company, this may not be an ideal solution for you.

There a lans available, which range from $49 to $499
per month depending on the number of users who will access
Slide Camp. There is a demo version as well, so you can try out
the service to see if it's right for your business.




6. Microsoft Events

While PowerPoint may be a tired way to handle a business
presentation at times, Microsoft has other tools that can
introduce a new level of practicality to the standard presentation.
It recently introduced the ability to create li d on-demand
events in Microsoft 365. These events can be viewed in real time
or on demand by remote co-workers or even workers who were
present in the meeting but want to reference what was said. It
combines HD video with machine learning to create a speaker
timeline, speech-to-text transcriptions and time coding, and
closed captioning.

Live events are part of the Office 365 subscription plans. If
you're already a subscriber, you can use this tool for no
additional cost.

7. Powtoon

Powtoon is an animated presentation and video platform for
creating short informational videos and presentations about your
brand or product. Explainer videos are an important part of a
brand's message, and Powtoon is an affordable tool for creating
animated videos and presentations to educate consumers and
clients about your business. You can easily edit presentations
and videos, add voiceover, and build a professional experience
fory stonders.

Powtoon offers a free version, but there are more robust
offerings at $19 and $59 per month.




8. Video Scribe

Video Scribe is a whiteboard video presentation platform that
allows small businesses to customize their presentations to fit
their needs. These videos, which feature a whiteboard and hand
that "draws" different objects and slides in t esentation, are
ideal for quick explainers and marketing videos on your
business or product. You can easily place objects, insert text,
and even draw your own objects or text with Video Scribe’s
platform.

Video Scribe is available for either $29 per user per month or, if
paid annually, $12 per user per month. If you want to extend
Video Scribe to a larger team, you'll have to pay $110 to $130
per user, depending on the number of users. You can also make
a one-time payment of $665 for a single user.

9. Prezi

Prezi is another template-based presentation solution that you
can use to create persuasive and engaging presentations with
unique movement between "slides" and key points. Prezi maps
out your whole presentation on an overall track that you decide.
When you switch slides, it doesn't simply advance to the next
one; it takes the viewer through the track to the point that needs
to be made. This allows your audience to visualize the
proWr presentation. You can arrange content under
differen and create an overview so your audience can
see your entire presentation plan. This method keeps the

presentation organized and your audience engaged. You can also
navigate freely through your presentation — your track is not




locked in and you can adjust when you address which points as
you're presenting.

Q14 (b) write the steps for the following action for creation of
power point presentation
e Open a blank presentation. ‘
e Save the presentation as lab1.pptx.

e Add a title to the first slide the name of your collage.
Type your first name and last name in the subtitle section.

e Add a new slide which has a title and content.

Ans. Opens a blank presentation.
» Select the File tab to go to backstage view.

» Select New on the left side of the window, and then
click Blank Presentation.

» A new presentation will appear.

SAVE THE PRESENTATION AS LAB 1. PPTX.
1. Locate and select the Save command on
the Quick Access Toolbar.
2. If you're saving the file for the first time, the Save As pane
will appear in backstage view.
3. You'll then need to choose where to save the file and give it
ick Browse to select a location on your
natively, you can click One Drive to save the

file to yo ne Drive.

4. The Save As dialog box will appear. Select the location where
you want to save the presentation.




5. Enter a file name for the presentation, then click Save.

6. The presentation will be saved. You can click
the Save command again to save your changes as you
modify the presentation.

You can also access the Save command by p‘ing Ctrl+S on
your keyboard.

Add a title to the first slide the name of your collage.

Select the slide whose layout yowwill ch so that
have a title.
Click Home > Layout.

Select Title Slide for a standa
select Title and Content for a sli

standalone title page or select Title and
that contains a title and a full slide text box.

4. Select the Click to add title text box.




Q15. Write steps for creation of a set of power point slides that
demonstrates your skills to use the tools of power point. It should
include the following things.

Title slide & bullet list
Inserting excel sheet
Clip art and text k
Slide show effects
. Title slide & bullet list o L
. Select the slide whose layout you will change so that it can have
a title.
. Click Home > Layout.
. Select Title Slide for a standalone title page or select Title and
Content for a slide that contains a title and a full slide text box. .

. Select the Click to add title text box.
an - a

BULLET LIST
A y 4

. On the View tab, click Normal.

. Click in the text box or placeholder where you want to add
bulleted or numbered text.

. On the Home tab, in the Paragraph group, click Bullets or
Numbering. , and begin typing your list. Press Return

_to create a new list item.

o ting excel sheet
e In Po n the Insert tab, click or tap Object.

» In the Insert Object dialog box, select Create from file.
» Click or tap Browse, and in the Browse box, find the Excel
workbook with the data you want to insert and link to.




» Before you close the Insert Object box, select Link, and
click OK.

Clip art and text.

» Display a slide that contains a Clip Art icon onfene of its
placeholders. ...

» Click the Clip Art icon to open the Clip Art task pane.

» In the Search For box, type a word that describes the artwork you
want; then click the Go button. ...

» Click the clip you want. ...

» (Optional) Move or resize the image as desired.

TEXT.
P o .

% Select a text placeholder or box.
& Type 1n the text you want.
A N W

SLIDE SHOW EFFECTS:
W - W
1.Start by opening a "Blank presentation" in PowerPoint.

2.Select the "Title Slide" option. ...
3.Type in your title and subtitle. ...
4.Select a background for the entire presentation. ...

5.Addw
6.Set the transitions for your slides. ...

/.Add some more pizzazz to
your presentation with animation!




Q16. What is the difference between machine language and
high level language?

Ans: High-Level Languages

A high-level language is a programming language that uses
English and mathematical symbols, like +, -,/% and many
others, in its instructions. When using the term "programming
languages,' most people are actually referring to high-level
languages. High-level languages are the languages most often
used by programmers to write programs. Examples of high-level
languages are C++, FORTRAN, Java and Python.

To get a flavor of what a high-level language actually looks like,
consider an ATM machine where someone wants to make a
withdrawal of $100. This amount needs to be compared to the
account balance to make sure there are enough funds. The

instruction in a high-level computer language would look
something like this:

x =100
1f balance x:

print 'Insufficient balance'
else:
print 'Please take your money'

This is not exactly how real people communicate, but it is much
casicr to, follow/than a series of 1s and Os in binary code.

There are amumber of advantages to high-level languages. The
first advantage is that high-level languages are much closer to
the logic of a human language. A high-level language uses a set
of rules that dictate how words and symbols can be put together




to form a program. Learning a high-level language is not unlike
learning another human language - you need to learn vocabulary
and grammar so you can make sentences. To learn a
programming language, you need to learn commands, syntax
and logic, which correspond closely to vocabulary and grammar.

The second advantage is that the code of most high-level
languages is portable and the same code can run on different
hardware. Both machine code and assembly languages are
hardware specific and not portable. This means that the machine
code used to run a program on one specific computer needs to be
modified to run on another computer. Portable code in a high-
level language can run on multiple computer systems without
modification. However, modifications to code in high-level
languages may be necessary because of the operating system.
For example, programs written for Windows typically don't run
on a Mac.

A high-level language cannot be understood directly by a
computer, and it needs to be translated into machine code. There
are two ways to do this, and they are related to how the program
is executed: a high-level language can be compiled or
interpreted.

MACHINE LANGUAGE:

Computer can understand only the language of Digital
Electronics. Digital Electronics deals with presence and absence
of voltages. Within the computer there are two logics can play
their rolc¢?These logics are —

. Positive Logic — Here presence of voltage will be denoted
by 1 and absence of voltage will be denoted by 0




. Negative Logic —Here presence of voltage will be denoted
by 0 and absence of voltage will be denoted by 1

But obviously computer can follow anyone of the logics at a
time, not both the logics simultaneously. To make the computer
understand, a program can be written using @nly Os and 1s. The
data can also be specified and represented using,only Os and 1s.
Such a program is called Machine Language progtam. Machine
language was the first in thed evolution of ") computer
programming languages. Computer directly understands a
program written in the machine language." So as a “restlt,
machine language programfdoes notttequire any translator to
convert from one form to \another. In“fact, even to this day,
basically computers understand only,the Os and 1s.

Disadvantages of machine languageyprogram = Writing a
program in machine language has the following,drawbacks.

. It is very tiresomeypto work with amd highly error prone.
While writing the program, a 1 and 0 can get interchanged
due to typographical €rror.»But then it 1s very difficult to
locate it for correction. So a machine language program is
very difficult to debug,

. Just having a lookhat'the program, it is very difficult to
visualize “the, function of the program. In fact, it is very
difficult to make out whether a particular bit sequence is an
instruction’in the program, or a data value, or the output
result. Asfinstructions, data, output and operands, all are
represented using Os and 1s in machine language.

. Machine language programs are platform and architecture-
dependent. The same program does not work on another
computer by a different manufacturer. This is because




machine language is different for different computers. Say
the bite pattern 11110000 means addition in one
architecture but might be representing subtraction in
architecture as well.

To develop a program in machine language, the
programmer must be highly conversant with the
organization and architecture of the computerisystem being
used.

Advantages of machine language progtam —They only
advantages of writing in machine language are

. The Machine language program 1S executed faster than a
program written in a_ highslevel Tanguage| (high-level
language is discussed a little Tater). The“effi€iency of the
program solely depends on the complexity of the program

itself.

. A translator like compiler or interpfeter is not needed and
sofresults in a cheaper computer system.

Q17. Discuss about different'data types € programming language.

Ans. Each variable in C has an associated data type. Each data type
requires different amounts of memory and has some specific
operations which can be performed over it. Let us briefly
describe them one by one:

Following are the examples of some very common data types
used 1n'Cx

. char: The most basic data type in C. It stores a single
character and requires a single byte of memory in almost all
compilers.




. Int: As the name suggests, an int variable is used to store an
integer.
. Float: It is used to store decimal numbers (numbers with
floating point value) with single precision.
. Double: It is used to store decimal numbers (numbers with
floating point value) with double precisic
Different data types also have different rangg
can store numbers. These ranges maygve
compiler. Below is list of ranges alg
requirement and format specifies o

short int -32,768 to 32,767

unsigned

short int 0 to 65,535

unsigned

int 0 to 4,294,967,295

-2,147,483,648 to

2,147,483,647




long int 22.147.483,648 t0 2,147,483,647

unsigned

long int 0 to 4,294,967,295

long long

int L(2763) to (263)-1

unsigned

long long

0to

Int 18,446,744,073,709,551,615

signed char —’ 128 to 127

unsN

char 1 0 to 255




long double |4 %Lt

We can use the size of () operatoR to check the size of a variable. See
the following C program for the usage of the various data types:

.

Q18. Find the output of the following expressions.
a) X= 20/5*2+30-5 b) Y=30-(40/10+6)+10
c) Z= 40*2/10-2+10
Ans.a) X= 20/5*2+30-5=33 (b) Y=30-(40/10+6)+10=30
c) Z= 40*2/10-2+10=16

Q19. Describe the syntax of the following statements.
a) else ement (b). for loop (c) while loop
d)d op

Ans. A) if — else statement- Syntax

The syntax of an if...else if...else statement in C programming
language i1s —




if (boolean_expression 1) {

/* executes when the Boolean expression 1 is true */
} else if (boolean_expression 2) {

/* executes when the Boolean expression 2 is true */
} else if (boolean_expression 3) {

/* executes when the Boolean expression 3 isitrue */

} else {
/* executes when the none of the abewe conditionis.true */

}
b) For loop: The syntax of the for loop is:

for (initializationStatement; testExpression; updateStatement)

{
// statements inside the body of loop

b
C) While loop: The syntax of the while loop is:

While (testExpression)
{

// statements inside the body of the loop
h

D) Do loop : // Program to add numbers until the user enters
Zero

#include <stdio.h>
int main()

{

double number, sum = 0;




// the body of the loop is executed at least once
do

{

Printf("Enter a number: ");
scanf("%]If", &number);
sum += number;

;
while (number != 0.0);
printf("Sum = %.21f",sum);

Return 0;

Q20. Find the output of the followings program segments »
a)

#include<stdio.h
> Int main()
{
inti;
for(i=1; i<2; i++)
{
Printf("IMS Ghaziabad\n™);

} N '
}
A20. a)Output- Ghaziabad

b)#include<stdio.h
> int main()




{
Int i=1;
while (i<=2 )
{
Printf(”IMS Ghaziabad\n”);

I=i+1;

}

}
A20.b)Output=IMS

Ghaziabad IMS
Ghaziabad

c)  #include<st
dio.h> void
main()
{
int
a=10,b=100;
if(a>b)
printf("’ Largest number is %d\n” ,a);
else

printf(“Largest number is %d\n” ‘b);

}
A20. C)Ou gest nois b”)
















